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Vi takker for jeres interesse for MicroStation Tips og Tricks preesentationen ved bentleyser.dk arsmgdet i
Vejle 2010. Hvis | ikke deltog i vores tips og tricks session, sa kan vi fortzelle at det var helt tilfaeldigt
hvilke tips der blev vist. Vi havde en stor bunke tips som vi bare hev frem fra.

Vi haber at der er nogle | maske har glemt og andre | maske ikke kendte til.

God forngjelse!

John & Tine
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1. ALT+DATA to Match
For at hurtigt elementers level, farve, linietype og tykkelse. Hold musen over elementet, og tast:
ALT+Data point. De aktive attributter andres sa de ligner elementet under musen.

2. Bentley DGN iFilter
Med Bentley’s DGN iFilter er det muligt at s@ge pa en tekst der ligger i en DGN eller en DWG fil vha.
Windows search eller Google Desktop.

Man kunne f.eks.sgge pa et tegningsnummer, et nummer pa en pumpe eller en adresse. — der kan sgges
pa alle tekster.

3. Change Reference View
| denne version kan du aendre Orientation pa en reference, ved at klikke pa Orientation kolonnen i
Reference Dialogboksen.

i References (1 of 1 unique, 1 displayed)
Tools Settings

EEEY R R L R e

Hierarchy File Name: Model | Orientation GeoCS
VBi Tips and Tr | [ e Anno... Coincident - Word
T Description
Coincident Aligned with Master File

Coincident - Word Global Origin aligned with Master File
Standard Views

Seale (1000000 | E Saved Views (none)
Offset X y| Mamed Fences none)

<3 (| % | [No Nesting )| [Allow Overidd

| e
4. Close all dialogs - luk alle dbne dialogbokse.

(maske mest for dem der ikke bruger ”"dokkedimserne”)

=

Hvis du midlertidig gerne vil slukke for alle dialogbokse, f.eks. Key-in browseren, reference dialog
boksen, cell library, tag dialog etc. ) sa kan du bruge fglgende key-in:

dmsg sinkall toggle

Og tast det samme for at fa dem frem igen - kan ogsa ligges i en function key.
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5. CTRL+RESET menu for at abne MAIN menuen

6. Display Priority

| en 2D model, kan du tildele elementerne prioritet, hvilket bestemmer hvilken raekkefglge
elementerne skal vises i. Elementet med den hgjeste prioritet vises forrest, og den med den
laveste prioritet vises bagerst.

Ment Semwngs |00IS UTITES VWOrkSpace  wWINndow 1o e

ds v| Pe~ == 0 uv@u{hﬂﬂuvi

7. Docking - "dokkedimser” B
Vi har faet en ny metode til at dokke dialogbokse. Nar man tager fati en

dialogboks kommer disse "dokke-dimser” frem. De viser hvor netop denne

dialogboks kan placeres. Traek musen henover indikatoren, og omradet hvor
dialogboksen kommer til at ligge highlights. Slip musen, og din dialogboks er ljl

parkeret. E EE'

8. Double Click for Fit View
En hurtig made at veelge Fit View er at dobbeltklikke pa den midterste
museknap. (hjulet)

9. Drag selection support efter du har valgt kommandoen

Efter at man har valgt kommandoen kan du nu ogsa veelge flere elementer ved at traekke musen
henover dem. Og hvis du ikke fik alle elementerne med sa kan du holde Ctrl tasten nede, og evt. traekke
endnu en firkant for at veelge flere elementer. — Og det er ikke et selection set.

10. Drag og Drop til attributes knapperne.

Hold musen over et element, mens du har Element Selection vaerktgjet valgt, nar elementet
highlighter traekker du det op i Attributes vaerktgjskassen, slip musetasten over den attribute
du gnsker at matche. Eksempelvis linietype.

Hvis du ogsa har taendt for knappen Symbology Preview i Attributes vaerktgjskassen, sa kan du
bruge drag og drop teknikken til at eendre alle attributterne.
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11. Edit Text
Du kan bruge element selection vaerktgjet til at veelge edit text. Du skal blot dobbeltklikke pa teksten, og
edit text abnes. (forudsaetningen er at man star pa de 2 fgrste i element Selection veerktgjet — Individual

0og new)

¥ Elemen... [

Bloco ., @
Ele=@3: B

12. Edit Texti Celler
Teksterne i cellerne kan du aendres direktet. Du skal blot dobbeltklikke pa teksten med Element
Selection, og Edit Text dialogboksen kommer frem.

: % Elemen... [C |[(1|X]
13. Element Selection Tabs SEES
. 0 020 s
Valger man elementer ud fra attributter, sa er der nu flere faneblade .7 ®
Ele=29 W .
at teende (5 stk.). — de er som standard gemt. H] 4|8 &
= ] El ] e Level
. . b L v Calor
For at teende dem hgjreklik > og veelg den egenskab der skal vaelges Emlnme I (7 Line Style
efte r. Annotation Cell i Line Weight
Arc v Element Type
g;:mj&i:egimz Element Class
Bspline Surface v Element Template
Cell Tl
Complex Chain L Text Style
Complex Shape v Dimension Style
Cone | Multi-line Style
Curve —
Detail Callout | v Transparency
Digtal Signature |/ pisplay Priority
Show All
List...

14. Geo-Coordination - Geografiske koordinatsystemer
Med MicroStation V8i fik vi geografiske koordinatsystemer i MicroStation, sa vi kan helt
ngjagtig angive hvor i verden vi befinder os. Disse koordinatsystemer kan veaelges under: Tools >
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Geographic > Select Geographic Coordinate System

4 Select Geographic Coordinate System
Library | Sgarch |

Favorites ~ Coordinate System

B[ Library
=- Projected (northing. easting. )

Africa
Antartica
Asia
Central America and Canbbea
2

Atlantic Islands

Austria

Belgium

Czechslovakia

Denmark
H- Danish System 1934
Danish System 1334
Danish System 1345

2 Geograph1c Coordinat... [Z @
HBERFPEF OGS

nBEE®

Current Geographic Coordinate System
Name: EPSG:2029

-- Danish System 1345 {
Description: MNAD27(76) / UTM zone 17N KP2000
Greenland
Source: EPSG -/ Estonia
Finland -

UTM’erne ligger her:
Library > Projected (Northing, Easting) > Europe > UTM / TM / GK Zones > ETRS89

4} Select Geographic Coordinate System
Library Search|

Spain ~
Sweden B
Switzerand

nEEEEE

UTM /TM / GK Zones
[ Pulkova 1342
Pulkovo 1342(1983)

[ Pulkovo 1535

= ETRS8%

{8} EPSG:2213 - ETF
TRS89.TM-30N
TRS89.UTM-28

ETRSRG [ITM.ZT

15. Jump to Active Level - hop til de aktive level [ [Name = =
Hvis du star i Level Manageren eller i Level Display dialogboksen, Trim Tools Llo -
. . . . Coordinate Cell Co -
og gerne vil hoppe til det aktive level, sa gor felgende: Display Styles Co -
ROW . e
| ailwa New
Hgjreklik pa et Levelnavn > Veaelg Jump to Active Level pa menuen Locals Set Active —
Private Re = -
M‘:::s | Jump To Active Level [
Collectors| Update Levels -
bypassin| 1500t evels B
bypassrar B
Township = = -
Private Remap Elements... -
County Select Al B
Kings = —
S0E-101A]  Select Hone 0
EQPREF |  Invert Selection o S
ROF-101R L —
Cut =
=~ Bentley — | '
_.j Sustaining Infrastructure Page 7 | - e
g Delete rated.
Rename
Properties |
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16. Level display dialog

Fa din level dialogboks til at se anderledes ud og fa mere plads til bade levelnavne og fil/reference listen.

Vs

EELL

| Vedical  |w

Link Tree Selection
[] Auto-amange items
Alow Docking

 Level Display - Vie... [= | 0 [[X] Follow Actve View
2 B Number Map Seftings

e I DGN Levels as:
‘ﬁ D:l fnone) ™ |Levels % @ = -

Uy 5 [VenDwly 9]
N ] L= o) ~ [Loves ] [A ~
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17. MS_DEFAULTSHEETRGB =R,G,B / MS_DEFAULTDRAWINGRGB =R,G,B
MS_DEFAULTSHEETRGB =R,G,B

Bruges til at kontrollere baggrundsfarven pa nye sheet modeller

Denne baggrundsfarve kan overskrives af color indstillingen i Workspace Preferences dialogboksen.

MS_DEFAULTDRAWINGRGB =R,G,B

Bruges til at kontrollere baggrundsfarven pa nye drawing modeller. Hvis variablen ikke er sat vil den
bruge en pre-defineret farve der hedder: RGB=192,192, 208 (grabla) Denne pre-definerede farve kan
ikke @ndres.

18. Named Groups (Quicksets) og Referencer
En anden made at tilknytte referencer er at bruge Named Groups eller maske QuickSets.

Fgrst laver man de named groups i referencen, og nar man tilknytter filen som reference vaelges den
named group, sa sa far du kun vist de elementer der er med i gruppen og resten er slukkede.

Reference Attachment Settings for V8i Tip...

File Name: V8 Tips and Tricks.dgn
Full Path: ..%2010 bertleyuser.dictd"V8i Tips and Tricks.dgn

Model: [- Index - v
Logical Name: | |
Description: | |
Orientation:
WView Description |
Coincident Aligned with Master File
Coincident - World Global Origin gligned with Master File

Standard Views
Saved Views (none)
MNamed Fences {none)
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19. Pin and Roll Tabs - Tegnstift og faneblade -
Nar dialogboksene sa er dokket, sa kan du vha. tegnestift ikonet fa dialogboksen til at skjule sig, og kun
ligge som et faneblad i kanten af vinduet.

Flyt musen henover fanebladet, og dialogboksen kommer frem, nar du flytter musen veek forsvinder den

igen.

E T 1L X | Lovel Display - view _ =

[ £ Tasks -] Beco. @ =0 2

A4 o

Z

tas N | T g = -3

BshpRAXs: | EHeode W o [E] D - ol - :

=

A Example Standards b E\-m Text.dgn, Index H %‘

‘ g B TextStyles, Text.dan, TextStyles =

lstnieckisempls - v FlaceT extOptions, Text.dgn. PlaceT ext0 ptions E

v FlaceM oteOptions, Text.dan, PlaceMoteOptions

B4 prawing

uoIafes Juswag ©F
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20. Raster Reference Geospatial PDFs

Geospatial PDF filer er nu supporteret sa de kan direkte tilknyttes som raster reference i Raster
Manageren. Hvis du hurtigt kan se om det din PDF er geospatial, sa tjek informationen under preview
nar du tilknytter, raster referencen.

Med koordinater: Uden koordinater
Preview Attachment "] - Preview Attachment
Raster Preview Raster Preview

P 794X 1123, RGB
Origin ¥: 703017379.3420 <no georeference >
¥: 4.9012E+09 L
[]Place Interactively

[JPlace interactively

Open Settings Dialog lisEerEn

21. Reference Activation
Med et langt hgjreklik kan du direkte komme til at @&ndre en reference vha. menupunktet: Activate
Reference.

Du kan se at elementer i andre modeller bliver gra, for at forteelle dig at du nu befinder dig i en anden
model. — hvis en anden har modellen aben, kan du naturligvis ikke abne den. Og du kan ogsa se pa
viewtitlen at du nu befinder dig i en anden model (og maske fil).

Nar man har lavet sine a&ndringer og skal retur til sin egen model igen, hgjreklikker man og veelger enten
Release lock eller Deactivate.
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&~ Create Drawing Title
3 | Activate
¥ Exchange 3 Copy
Level Off ;5:;':', Move
5 Copy Reference I':'; Scale
24 Move Reference "%, Rotate
43 Scale Reference 144 Mirror
o
7: Rotate Reference 8 [E] | Deactivate Default
% Clip Reference |H FE
w1 Detach Reference F Release lock on SnapMode.dgn]
(@ Set Reference Presentation Level U
1 Farallel
@ select Al 4
2% Select None 8 selectal
s ) la% Select None
¥ ' Select Previous 1
) 1§ Select Previous
¥ Displayset Set X )
K- Displayset Set
A& Cut to Clipboard & Cutto Clipboard
% Copy to Clipboard 2y Copy to Clipboard
@ Paste from Clipboard B Paste from Clipboard
X Delete Element »_ Delete Element
(i) Element Information (7) Element Information

Der en vaesentlig forskel pa de 2 valgmuligheder. Med de-activate har man stadig fingrene i
modellen/filen, og hvis man bruger UNDO vil den ogsa huske de aendringer du lavede pa referencen.
Man har ogsa filen Iast, sa hvis andre forsgger at abne den, vil den vaere read only. Hvis man bruger
Release lock svarer det til at man lukker filen, og den er sa helt ”frigivet”.
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22. Remap Elements i Level Manager

En hurtig made at rydde op i sine data er at bruge Remap Elements i Level manageren. Man bruger den

hvis alle elementer pa ét eller flere levels skal flyttes over pa et andet.

Abn Level Manageren > Hgjreklik pa de levels, hvor de elementer der skal flyttes > Vaelg Remap

Elements > Vaelg det level de skal ligge pa.

% Level Manager
Levels Filter Edit

23 (22 | smboooy 12 e~ A -

=

| Active Level: 0107_Welds

Cut
Copy

W Vi Tips and Tricksd | A | Name =
£§ Al Levels Trim Tools Clo —
[ Fiters Coordinate Cell Oo _

Display Styles Oo N
ROW wout Ty E
Locals Set Active
i, Jump To Active Level
Arerials Update Levels
Collectors
Import Levels
bypass ramp  Save Filte —
Township Remap Elements... [
Private
County Select Al —
Kings Select None —
S0E-101A _ ™
EQPREF Invert Selection DN
£ | 2 SOF-101R b
kd
j—

Delete

Properties |
23. Save print definition file
Skal man printe samme fil pa samme made, og vil man gemme indstillingerne fra print dialogboksen, sa

kan man gemme en pset fil fra print dialogboksen

‘4! Print (pdf.pltcfg)

File | Settings PenTable
1 Open Print Definition Fie...

|__Save Print Definition Fie...

Preview

Eterzed

Remap Elements to Level

. <Muttiple>
[ ok ] [ comcel |

Naeste gang man skal printe filen, abnes print definition filen. Enten vha. print dialogboksen, eller

igennem Print Organiseren.
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24. Selection Line mode
Traek og hold ALT tasten nede, sa bliver firkanten til en linie. Hold ALT tasten nede og kom retur til
firkanten.

25. Selection Overlap mode er hgjre mod venstre
For at vaelge elementer i overlap mode (alt hvad der er indenfor og overlapper). Treek musen
fra hgjre mod venstre. For Inside (alt hvad der er indenfor) traek fra venstre mod hgjre.

Valgte du forkert kan du taste SHIFT og den ggr det modsatte.
26. SHIFT+RESET menu for at abne open View menu

27. Snapmode som preference
Der er en variable, der kan angive om det er filen der skal bestemme hvilken snap mode der
veelges, eller om det er brugeren.

Indstil: MS_SNAPMODE_SOURCE = 0 — hvis der er filen der skal bestemme.
Indstil MS_SNAPMODE_SOURCE = 1 — hvis det er dig.

£4 pDrawing

3 NS A+ M
N < - Lo
WO xR O E
qO o/ >n M

-

FETRY K
2D
1 Bo P 002 B

A 4 AE =4 J«:" At "\ Text Editor - Word Processor

dg 1, ma 1 o
A AT 4 aaaTm Ty AN

W oaed o o 00 9
R
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28. TextStyles and DimensionStyle differences
Find forskellene pa dine styles.

2 Text Styles - StyleA (Active : Style (none))
Style  View

E- | DA% X2}

Text Styles
Styte fnone)

—
* Styich
¥ StyieB
)

Genersl | Spacing | Linder/Overine | Ea:k;munl | Advanced | |

Name StyleA Name

StyleB

B
K

‘ %C.lbl
SETMEN

\arkin o tooeth

4! Dimension Styles - DimStyleA (Active : Style:(none)) E]|E|@

Style  View

Dimension Styles
Style:{none)

Font Oz Adal Font [Fx] Bemard MT Conde
Height 0.2500 Height 1.0000
\fidth 0.2500 Width 1.0000

Justification  Left Top

Color Flag  True Color Flag

Justification Center Descender

False

Line Spacing 2 Line Spacing 1

29. Trim Tools

7+7 - Trim Element vaerktgjet har faet nyt navn og metoderne hedder nu: Trim Multiple, Trim, Extend og

Trim and Extend.

E- | D@% [ X&a2.d

Geometry | Units | Text | Symboloy

g,‘\ Advanced | |

=

[] Compare with library

P. DimStyleA Dim StyleB
u O

U (Millimeters) Decimeters
U {mm) su

U (Meters) Meters

U {m) mu
U01234 0.12

U 01234 0.1

T Style {none) L& StyleB
N O

G 3.500000 1.000000
G DimStyleA DimStyleB

Modify Element

=X Partial Delete

j:r/ Break Element By Point
= Extend Line

/\ Trim To Intersection
/\‘- Trim To Element
|-Tj: Trim Multiple

1 IntelliTrim

i Insert Vertex

19 Delete Vertex

- Construct Circular Fillet
™~ Construct Chamfer
uer| Open 'Modify' as Toolbox

Beniley
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e Trim er default metoden, og virker stort set som den gamle Trim Element
e Extend metoden er lant fra IntelliTrim vaerktgjet

e Trim and Extend er en ny metode der lader dig bade trimme og forlaenge elemnterne i én
arbejdsgang.

Ligemeget hvilken metode du har valgt (efter du har valgt det skaerende element), kan du velge flere
elementer der skal trimmes, ved at traekke musen hen over dem.

7+6 - Extend Element to Intersection vaerktgjet hedder nu Extend To Element.

Default opfgrer den sig som fgr. Men man kan nu vaelge nye metoder, der ggr at du kan nu vaelge det
skeerende element fgr du trimmer. Nar dette flueben er aktiveret, er det muligt at traekke musen
henover flere elementer, og dermed trimme flere elementer pa én gang.

When this tool setting is on, after you select the cutting element, you can select multiple elements by
dragging a selection line across them to simultaneously extend and/or shorten them.

1 Modify Element

2 Partial Delete

3 Break Element By Point

4 Extend Line

>N G [

3 Trim To Intersection

& Trim To Element

Trim Multiple

=

o |
~

8 IntelliTrim

Insert Vertex

(- -
= k')‘
(=T =]

Delete Vertex
Construct Circular Fillet

W Construct Chamfer

A
=)
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7+5 - Extend Two Elements to Intersection vaerktgjet hedder nu Extend To Intersection, og kan nu
forkorte og forlaeenge alle elementtyper, eksempelvis B-splines

1 Modify Element

X 2 Partial Delete

/—'::/ 3 Break Element By Point

/" 4 Extend Line

‘/\ 5 Trim To Intersection

,k— & Trim To Element

£t 7 Trim Multiple

¥ & IntelliTrim

¥ 9 Insert Vertex

I% 0 Delete Vertex

—‘] Q Construct Circular Fillet
_\I W Construct Chamfer

30. Print Styles

PrintStyles bruges til at 2endre eller tilfgje hvordan en model skal printes. Det er en metode til at gemme
hvordan man normalt vil indstille plot dialogboksen. En print Style defineres gerne i et dgnlib, sa en hel

organisation eller et projekt kan have glaede af standard print opsaetningerne.

! Print (pdf.plicfg)

File | Settings | Resymbolization

;,; Units »
Update from View
Gen

Set Fence from Fit Al
Bre

=7 SetFence from Fit Master

Eel Apply Print Style |

Col|  Print Attributes 1
Frint Levels/References

Prim  Raster Options

@ 3D Plotting

Hidden Line Removal —
Pap -]
Preferences

Usa
. . 1 I 1

31. Quicker Popups Hurtigere Popups -

| V8.x og V8 XM kan du kontrollere hastigheden af pop-up dialogboksene. Du kan szette hastigheden

ned, eller ggre den hurtigere ved hjaelp af fglgende configuration variabel:

MS_POPUPDIALOGCLOSEDELAY
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32. Right click task - hgjreklik pa en task

Hvis man hgjreklikker pa en task for man flere valgmuligheder:

e Show/Hide Tools > (Tools' names) — Sa kan du taende og slukke for hvert enkelt veerktgj.

e Show/Hide Tools > Show All — S3 vises alle vaerktgjerne.

e Show/Hide Tools > List — Lister alle veerktgjerne sa du kan taende slukke for hvert enkelt
veerktgj.
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